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Purpose of this Tutorial

The initial HRPP accreditation application to AAHRPP requires submission of PDF files and spreadsheets.  Some files are submitted in both paper and electronic form; others are submitted only in paper form.  Following the AAHRPP site visit, your VA Facility will receive a Draft Site Visit Report from AAHRPP.  Your VA Facility will have 30 days to submit a response to the Draft Site Visit Report.  Unlike the initial AAHRPP application, the response to the Draft Site Visit Report requires submission of a single PDF file in both paper and electronic form. 

This tutorial describes how to prepare the PDF file for the response to the Draft Site Visit Report by discussing content and technical issues. Creation of PDF files using Microsoft Office files, websites, electronic forms, and scanned documents are based on Adobe Acrobat 7.0 Professional and Microsoft Windows XP Professional Version 2002.

Reviewing the Site Visit Report

When your VA Facility receives the Draft Site Visit Report, each evaluated Element will be described.  Descriptions of the evaluated Elements will include observations specific to the VA Facility’s application materials and site visit.  Each evaluated Element will also include the following language: “Council Determination: Pending.” Only the AAHRPP Council can determine whether an Element is met.

This does not mean that your VA Facility needs to respond to each Element.  The only Elements where a response is needed are where observations are listed after the heading “Areas of Concern.” These observations are statements about what your facility needs to address (e.g. deficit policies, training of research personnel) in order for the Element to be met.

Example of Draft Site Visit Report:
	Element I.3.B: The Organization has and follows written policies and procedures that allow the Research Review Unit to function independently of other organizational entities in its role in protecting research participants. 
	Observations: 
The Medical Center Director did not allow the organization to approve research that had not been approved by the IRB.
IRB member and staff knew to report undue influence to the Research and Development Committee, the Associate Chief of Staff for Research, or the Medical Center Director, who were responsible to investigate any allegation of undue influence and take corrective action. 
Areas of Concern: 
The Medical Center Director had not granted the IRB the authorities to:
Observe, or have a third party observe, the consent process and the conduct of the research.
Council Determination: 
Pending 


Errors

As you review the Draft Site Visit report, check for any errors.  For example, an observation listed under “Areas of Concern” for Element  II.2.B. might state, “Policies and procedures did not describe procedures for approving research using an expedited review process.”  However, the submitted application included a description of policies and procedures used by the IRB for approving research using an expedited review process.  In this example, reference the policies and procedures in the draft site visit response to the Element. 

You have 30 days after receiving the site visit report to provide AAHRPP a written response describing any errors in observations listed as “Areas of Concern.”  

Suggestions Made During Site Visit

Your VA Facility may receive oral comments during the site visit suggesting ways to address specific Elements and/or issues with evaluated Elements.  The Draft Site Visit Report usually reflects the issues identified by the site visitors.  However, there may be observations described as “Areas of Concern” that were not discussed during the site visit.  There may also be Elements where issues identified by the site visitors were not described as “Areas of Concern” for the applicable Element in the Draft Site Visit Report.

PLEASE NOTE:  Only respond to observations described as “Areas of Concern”.  You are not required to follow any suggestions made by site surveyors during the site visit unless the comments appear in the draft site visit report as “Areas of Concern.”  Suggestions are exactly what they are:  suggestions.  It is up to your judgment whether to accept or not accept suggestions based on your evaluation of the suggestions’ usefulness or applicability to your Human Research Protection Program (HRPP).


Clarifying Observations

The observations listed in the Draft Site Visit Report are not always clear and/or may be interpreted multiple ways.  During, or immediately after your site visit, you will be assigned an AAHRPP staff person to direct questions about your Draft Site Visit Report or preparing the response.  He or she will usually be the AAHRPP staff person who was part of your site visit team.  

Questions about how to address observations or recommendations in your response to the site visit report should usually be directed to this individual by calling (202) 783-1112 or the e-mail address specific to the AAHRPP staff person.

Obtaining Feedback

You should be asking your AAHRPP staff person for feedback on your response before it is formally submitted.  For example, AAHRPP can review a revised policy or a response to a specific Element.  When you ask AAHRPP for feedback, please include only one Element per email, include the Element number in the subject line, attach a Microsoft Word file with the point-by-point response, and attached all modified documents relevant to the Element. It does not matter that you may be sending the same documents with multiple emails.  AAHRPP staff can be emailed at Accredit@aahrpp.com if you are unsure of the e-mail address specific to the AAHRPP site person assigned to your VA Facility.

Note: You should be talking to AAHRPP throughout the response process. You may also contact COACH for assistance in responding to the Elements. 

Preparing the Response

Section A:  Addressing the Elements

Once you have reviewed the Draft Site Visit Report, you can begin to prepare the response.  The response will consist of two Sections:


Section A:  Response to the Elements


Section B:  Supporting Documents

Section A is similar to Section C (Element by Element Index to the Supporting Documents) in the initial AAHRPP application.  Section B is similar to Section D of the initial AAHRPP application.

The next section of this tutorial will describe general formatting and content issues to remember when preparing Section A and Section B.


Section A: Formatting

You will receive your Draft Site Visit Report in hard copy (paper).  You can request an electronic copy from AAHRPP.  An electronic copy will make it easier to create the response.  

Your response needs to include only those Elements that have an associated “Areas of Concern.”   If there is not an “Areas of Concern”, cut the Element from the response document. 

For each Element in your response, include: 

· the Element number and the text of the Element

· the text of the AAHRPP observation listed as “Areas of Concern”

· the text of the “Areas of Concern”, list of any documents changed, and any actions taken (include the document number and enough information to point AAHRPP where they need to look)

The following is an example of how a typical response could be formatted:
Element I.2.C: The Organization provides resources that are necessary for human research protection, care of research participants, and safety during the conduct of the research.
 
Areas of Concern:
Policies and procedures should describe the process followed by the organization to provide resources necessary for human research protection and the care and safety of participants during the conduct of the research.

Section A: Example of Formatting

Observation:
Policies and procedures did not describe the organization’s evaluation or the IRB’s evaluation of each protocol to determine whether it had adequate resources to protect the rights and welfare of participants in terms of:

· Adequate numbers of qualified staff.

· Adequate facilities.

· Access to a population that would allow recruitment of the required number of participants.

· A process to ensure that persons assisting with the research were adequately informed about the protocol and their research-related duties and functions.
 

Response:

· SOP 839 (Document #15) page 3, paragraph 2 for the R&D's process to evaluate resources for the research. 

· R&D Review Checklist (Document #16) new questions 12-15 dealing with evaluating research resources. 
Section A:  Addressing the Elements

Responses should reflect changes to your policies and procedures or actions taken to ensure that your practices follow your policies and procedures.  Include the actions taken to implement the change.  

For example, changes that affect IRB members might be communicated and discussed at an IRB meeting.  If applicable, describe how you will track the effectiveness of the change. 

Avoid general statements, such as “The VA takes non-compliance seriously” or “Investigators carefully conduct the informed consent process.”  Instead, provide enough objective detail to address the observations described as “Areas of Concern” for the applicable Elements. 

In your response, refer to the Supporting Documents that will be submitted in Section B.  Identify the document number and point out the relevant sections, pages, paragraphs, or lines to make it easy for AAHRPP to locate the specific information in Section B that supports your VA Facility’s response. 

Tip:   
Use highlighting or track changes in the Supporting Document to make it easier for AAHRPP to evaluate exactly where changes have been made. 


Section B:  Supporting Documents

Section B should include a copy of each Supporting Document ordered by reference number.  Include only one copy even when the document supports more than one Element or more than one observation.  For long documents with a few changes, you need only submit the changed pages.  Use highlighting or track changes in the Supporting Document to point out specific revisions. 

Websites may change frequently; therefore, printed copies of all pages of your website referenced in the response should be included.  Hyperlinks to your web based documents should link to the PDF document and not to the website.  AAHRPP will not consider information posted on your website if it is not included in the response.

Do not include publicly available documents not authored by your organization, such as the Belmont Report, regulations, and professional society codes of conduct.  Reference these by name.  Do not include websites not created by your organization, such as websites for government, research training, or information services.  

Before You Begin Creating the PDF File: 

Cover Letter 

AAHRPP requires a cover letter to be included with the response.  The original cover letter must:

· Be signed by the organizational official who signed the original application, and

· Be submitted with the response.
AAHRPP does not specifically require the cover letter to be included in the PDF file comprising the response.  However, if you choose to include the cover letter with the response, have it signed, scanned, and converted to a PDF file prior to merging it with the two Sections of the response. 

General Issues

Important: Before beginning this project, do not add any headers, footers, or other text to scanned documents at this time.  This will be addressed when you create your final document.

· Allow yourself at least one week to assemble the response.

· Avoid use of “funny fonts” or embedded symbols in documents to be converted to PDF.

· Avoid use of scanned documents. 

· Do not scan in grayscale or color, use black and white when scanning.

· Scan in 300 dpi or higher.

· If you want page numbers in your individual documents, create these in the original documents before converting to PDF.

· Avoid having other programs open (such as your email and Word documents) when converting documents into PDF files using Adobe Acrobat 7.0.

Creating the PDF File

This section of the tutorial will address how to create the single PDF file comprised of Section A (Response to the Elements) and Section B (Supporting Documents). 

Requirements for the PDF file include:

· The response and supporting documents must be converted into a  single PDF file;

· The PDF file must be readable and searchable;

· The PDF file must contain page numbers; 

· Bookmarks must be used for to identify each of the following:

· Sections of the response,

· Each Element in Section A, and

· Each Supporting Document in Section B.

File Management Tips

· Keep all documents related to your response in one place.  

· Name the documents so that everyone is clear which document it is. 

· Date each document after its name so that you can keep up with versions. If you make another change on the same day, add a letter at the end of the date.  For example:  AAHRPP Response.60608B.

· You may want to save each of the documents used for your Supporting Documents with both the number and title (e.g. Document 3- IRB SOP). 

· If there are documents on several computers, you may want to keep them all on the server.  Ask your IT department to create a shared space that everyone on the application team from your facility can access. 

· Remember to back up your files.  Make a habit of backing them up at the end of each day.
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Converting Websites

You can download and convert web pages from the top level of a URL, with each web page becoming multiple PDF pages if necessary.  You can determine whether to download pages from the top level of a site, from a specified number of levels below the top level, or the entire site.

Note:  Some websites have hundreds of pages and can take a long time to download, as well as use up your systems hard disk space and available memory, causing your system to crash.  Begin by downloading only a few levels at a time.
1. Open the Adobe Acrobat software program.

2. From the menu, select 

· File 

· Create PDF 

· From Web Page 
· Enter the Web site URL
· Enter settings 

· 5 levels (depending on how many pages you want)

· Stay on same path

· Stay on same server
· Click Create 
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Note: Word documents on the website will need to be converted using the instructions “To Convert Files”, described in the previous pages. 

Converting Electronic Forms

Let’s say you want to convert the AAHRPP Application Form into a PDF.  Do not use a screen capture program or the windows Print Screen Function.  The first thing you need to do open an Internet browser window (Explorer or Netscape) and bring up a web page.  Note:  This conversion technique could also be helpful if you want to reference a specific policy posted on a webpage.
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From the menu select:

· File 

· Print
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Click on the Properties button

· Click on the Adobe PDF Settings tab

· Make sure the Adobe PDF Page Size is Tabloid
· [image: image10.png]‘;.‘ Adobe Acrobat Professional




Click on the layout tab

· Make sure the orientation is landscape

· Click OK

Note:  If the right hand margin is cut off, then in the Web browser, from the menu, select File > Print Setup.  Select a larger paper size, such as “Tabloid”. 
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· Save the file with a descriptive name and today’s date

Note:  If the electronic form is a “smart form” with built-in logic, include a flow chart or other description of the form’s logic.

Converting Microsoft Office Files
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Open the Adobe Acrobat software program

· From the menu select file
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· Then select: 
· Create PDF 

· From File 
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· Lastly, browse to select the files to be converted and click OK.  

Use of Scanned Documents

You will not need to scan numerous documents as part of your AAHRPP response.    Remember these key points when preparing documents for scanning:

· Do not use scanned documents when an electronic version is available.  For example, do not scan an investigator’s handbook when it is available as a word document.  Convert 
the word document into a PDF file using Adobe Acrobat. 
· Do not scan policies and procedures even if they are signed individually.  Send unsigned copies in the AAHRPP response.  
· Do not use grayscale or color scanning, use black and white when scanning. Scan in 300 dpi.  

Optical Character Recognition

You can create an Adobe PDF file directly from a paper document using a scanner.  

During scanning, you can specify whether to create a searchable PDF file by applying optical character recognition (OCR), or create an image-only PDF- that is a bitmap picture of the pages that can be viewed but not searched.  If your scanned document is the latter, you will apply OCR in your PDF file.  Either way, for AAHRPP’s purposes, a file with OCR is required.

Note:  This process may take a long time based on the size of the document. 
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Open the Adobe Acrobat software program

· Open a previously scanned document:

· File

· Open

· Select a document

· Double click on the file you want opened

· [image: image17.jpg]Window Help

|Comment 8 Matap- o SenlocReen f{Seare - /e s Foms+
v ot




[image: image18.png]g Adobe Acrobat Professional - [Accreditation Procedures Updatec

Lo
j\ File Edit View Document Comments Tools Advanced Window Help
£

2 & A s M- F- @ M sSearch | T Create POF - 3 Comment & Markup = o
55% .| ¥t | @Hep-~

Pages | _Signatures | Bookmarks |

Model Tree



Once your document is open, select document from the top menu in Adobe

· Click Recognize Text Using OCR

· Click Start 
· In the “Recognize Text” dialog box, Select All Pages and click OK. (If the file is very large, you may need to do 500 pages at a time.)

· If you get the error “Acrobat could not perform recognition (OCR) on this page because “This page contains renderable text” first check that you have not added headers, footers, or other text to any scanned pages. 

· If not, check “Ignore future errors in this document” and click OK. 

· After completing the OCR, you can check to see the process worked by trying to highlight the scanned pages.

Merging Documents Into One PDF File
[image: image19.png]E Adobe Acrobat Professional - [Accreditation Procedures Update

! File Edit View Document Comments Tools Advanced Window Help
o

2™ H s M- @ M Search | % Create POF - 5 Comment & Markup =
) |I» Select i . 55% - | ¥t | @Help-

Model Tree f Pages | Signatures | Bookmarks



You can convert different types of files and combine them into one PDF file.  This is what is expected for the response to the Draft Site Visit Report. 
· Open the Adobe Acrobat software program

· From the menu select 

· File

· Create PDF

· From multiple files
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Click Browse to select the files to be added.  You will do this several times, until all the files you want are in the list.  Note here that you can directly import your Microsoft Word files. They do not have to be converted to PDF first.

· Tip:  You can add files multiple times.  For example, you might want to add blank pages between sections.

· To arrange files, use Move Up and Move Down buttons.

· Click OK 

Creating Bookmarks

Bookmarks are created to make navigating through a large document easier.

Bookmarks must be used for to identify each of the following:

· Sections of the response,

· Each Element in Section A, and

· Each Supporting Document in Section B.

To create a new bookmark: 
· Open the page where you want the bookmark to link to (your final document), and adjust the view settings to about 55%.  
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· Click the select tool and drag to select text where you’d like your bookmark to be.  The selected text becomes the label of the new bookmark.  

· The bookmark will appear wherever on the page you began, thus you may want to align the page at the top prior to selecting and dragging your text.
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· Click the bookmarks tab, and click the bookmark under which you want to place the new bookmark. (This example does not have a list of bookmarks yet.) If you do not select a bookmark, the new bookmark is automatically added at the end of the list.

· Choose New Bookmark from the Options menu, or click the New Bookmark icon at the top of the Bookmark tab.

· Type or edit the name of the new bookmark, and press Enter.
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(Optional)

Using the Link tool via menu:

Hyperlinks are an optional way you can choose to use in addition to the required bookmarking.  Hyperlinks allow you to jump to other locations in the same document.  Creating links ensures the reader is able to quickly access your supporting documents.
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The link tool is used to create links.
To create a link using the Link tool: Go to where you want

to create a link from in the document.

· Choose Tools> Advanced Editing > Link Tool, or select the Link tool on the Advanced Editing toolbar.  The pointer becomes a cross hair (+), and any existing links in the document, including invisible links, are temporarily visible.
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Drag the (+) to create a rectangle.  This is the area where the link will be active.
· In the Create Link dialog box, choose the settings you want for the link appearance.

· Link type = Visible

· Link Action = Go to a page view

· Click the Next button
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· Click Set LinkThe text you want to hyperlink is now outlined in a bold, red line.
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Go to the bookmarks in the left margin.  

· Right click on the bookmark that you want to link.  

· Click on “Set Destination”.

To test if your hyperlink is working:

· Grab the hand too;

· Point to the hyperlink and left click on the hyperlink.  You should now see the page linked to the hyperlink.

To delete a link: 

· Select the Link tool.

· Select the link rectangle you want to delete.

· Choose Edit>Delete, or press the Delete key.

To move or resize a link rectangle:

· Select the Link tool and then move the pointer over the link rectangle.  The cross-hair changes to an arrow when the pointer is over a corner.

· Do one of the following:

· To move the link rectangle, position the arrow anywhere in the rectangle, and drag it to the new location.

· To resize the link rectangle, drag any corner point until the rectangle is the size you want.

Adding Headers and Footers
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Headers and footers are used to present information, such as the date, page numbers, or the title of the document, in the top or bottom margins of the document.

· Open the Adobe Acrobat software program

· Open the FINAL document (the one you plan on submitting):

· File

· Open

· Select a document

· Double click on the file you want opened

· After the document is opened, select “Document” from the top menu
· Click Add Headers & Footers
· In the dialog box, click the Header tab.

· Page numbers:

· Click in the right-hand box

· Select a style from the insert page number menu

· Click insert

· Select Arial 14 as the font

· Apply to all pages

· Set the right-hand margin at 0.5

· Click OK

· Repeat the same procedures for the footer so that you have page numbers at the top and bottom of each page

· If you need to renumber the pages later because you added or deleted pages, repeat these steps replacing the existing header or footer (see blue oval on image).
When is the Response Due?

You have 30 days after receiving the Draft Site Visit Report to address the “Areas of Concern” for the applicable Elements and describe any changes in policies, procedures, or practice (e.g. training in policies or procedures).   The response to the Draft Site Visit report is one of three documents reviewed and evaluated by the AAHRPP Council on Accreditation when making an accreditation decision.  

The other two documents are: 

1. The AAHRPP application, and 

2. Draft Site Visit Report.   

Preparing the Response

What if there is not enough Time?

It is important to respond to the observations within 30 days because the AAHRPP Council on Accreditation will use your response when making determination of accreditation.  If no response is received, the AAHRPP Council will still evaluate your VA Facility without a response.  

Do not skip addressing an Element’s “Areas of Concern” just because you can not completely meet the Element within 30 days.  Even if it takes longer than 30 days to implement a change, it is important to address the observations described in the “Areas of Concern” and describe what action you will take and how long it will take to meet the Element. 

Unresolved Areas of Concern

Sometimes it may be difficult or not feasible to develop and implement a plan within 30 days for observations to all Areas of Concern cited in the Draft Site Visit Report.   

It is acceptable to inform AAHRPP that your VA Facility is developing a plan to address specific observations cited in the Draft Site Visit Report, even though it may not be a full response with an implemented plan for each observation.  Do not wait and respond to the Draft Site Visit Report past the deadline.  Responses submitted after the deadline will not be reviewed until a later AAHRPP Council meeting.

Formatting, Assembly and Mailing

Formatting

Use a 12-point font with single-spaced, blocked paragraphs. Format to letter sized (81/2” x 11”) or A4 sized (210 x 297 mm) paper.

Assembly

Paper Copies

· Print out the PDF file containing Sections A and B.  

· The paper copy must be an exact printout of the PDF file on CD-ROM. 

· Printed responses should be fully collated.

· The amount of hard copies you need to submit are based upon the current number of active protocols your HRPP is overseeing.  
	# of Active Protocols
	Copies

	1-500
	3

	500-4000
	5

	>4000
	7


Electronic Copy

Submit the electronic document on CD-ROM as a single PDF file.  No printed documents should be submitted that are not in the electronic document.  No electronic documents should be submitted that are not printed.

Convert documents directly to PDF and use software that converts entire websites to PDF (We recommend Adobe Acrobat 7.0.) You can scan documents at 300 dpi black and white on a high quality scanner.  Scanning services can be obtained at local copy and print shops.  Generally, organizations either create an electronic version of their response and print out paper copies, or create a paper version and scan the document.

If you scan portions of your document, make all scanned pages searchable through optical character recognition.  Add required bookmarks to make the electronic document easy to navigate.

Please call AAHRPP for help or advice on preparation of the electronic document.  AAHRPP staff can be called at (202) 783-1112 or emailed at Accredit@aahrpp.com.  You may also contact COACH for assistance. 

Mailing

Meeting the Deadline:  Murphy’s Rule suggests that when in a time crunch; expect delays in the shipment of your materials!  When using US Mail, Fed Ex, UPS, etc... Please make sure cushion time is built into the timeline to deal with the unexpected.  

Before handing over items for shipment, make sure you know when the carrier’s shipment and delivery times are. 

Keep a copy of the receipt, and track the shipment.  All major transportation entities now have online access to shipment management, and can be very helpful in processing and following-up on your shipment.  It may be helpful to become familiar with the online environment with your contracted carrier.  

Remember, if your materials do not reach AAHRPP before the deadline, it will not be reviewed at the next scheduled council meeting.

Send the Final Product to:

Submit the correct number of paper copies and one (1) electronic copy to the following address:


Peter Vasilenko, Ph.D.


Vice President for Accreditation


AAHRPP


2301 M Street NW, Suite 500


Washington, DC 20037


In addition to sending the final product to AAHRPP, please send one electronic copy (no paper copies) of your AAHRPP response on CD-ROM to the following address.  Please send using a carrier such as Federal Express or UPS (not US mail).




Soundia A. Duche

Department of Veterans Affairs

Office of Research & Development/PRIDE (10P9P)

810 Vermont Ave., NW

Washington, DC 20420


After Response is Mailed

If your response has been received by the deadline, it will be evaluated at its scheduled AAHRPP council meeting.  

Following the AAHRPP council meeting, your VA Facility will be informed of the accreditation decision.  The report received following the council meeting, called the Final Site Visit Report, will inform you of the Council’s determinations on the “Areas of Concern” described in the Draft Site Visit Report.  

If AAHRPP requires additional actions for your VA Facility to take prior to awarding a qualified or full accreditation decision, your institution will be informed when your next response will be due to be considered at a subsequent AAHRPP council meeting. 

Response Checklist
Section A: Response to the Elements

· Elements that require a response (“Areas of Concern”) are addressed.
· Elements that require a response have a list of Supporting Documents.
· All Supporting Documents are included in Section B.
· All Supporting Documents are referenced by number.
· The index includes information that identifies the relevant portion of Supporting Documents.

Section B: Supporting Documents

· All Organizational documents listed in Section A are included.
· All documents are numbered.
· Revisions to previously submitted documents are indicated by highlighting or track changes.
· Double-check the bookmark feature of the PDF file to ensure that AAHRPP representatives can easily find the intended documents.
· Publicly available documents not authored by your Organization are not included.
· References to websites authored by the organization include a printout of all relevant WebPages.
· Websites not created by the organization are referenced by URL and are not included.
· All hyperlinks to your organization’s web-based documents link to within the PDF document.
Assembly and Mailing  

· The correct number of paper copies is included.
· An original cover letter signed by the organizational official who signed the original application is included with the paper copies.

· Printed copies are fully collated.
· One electronic copy is included on CD-ROM (not DVD).
· The CD-ROM is in protective packaging.
· The CD-ROM contains a single PDF document.
· Scanned documents are 300 dpi black and white.
· All printed documents are included in the electronic document.
· One electronic copy (CD-ROM) is mailed to ORD. 

Who to Contact for Help

AAHRPP:  
Help with instructions to apply for AAHRPP Accreditation; 
Help with AAHRPP accreditation Frequently Asked Questions

(202) 783-1112, Accredit@aahrpp.com
COACH:  
Help with questions regarding Adobe or how to format your response
Erica Doruska, (715) 343-1761, Erica.Doruska@va.gov 
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Note:  


Table of Contents


 is linked to the pages 


in the document.





Simply Ctrl +Click to go to the desired page.
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